








When the conversion is complete, you'll see the finished screen. Click the
mouse to return to the regular menus.

To save the converted image, you would click on DHR.Test to select that
image, and then choose Szve As from the File menu.

Another example...

Let's try a conversion to the Super High Resolution screen. Before
proceeding, let's free up the memory used by DHR.Test, by clicking on
DHR.Test, and then choosing Dispose from the file menu. No other graphic
names should be selected when you do this. Remember, you can use the
Apple-key while clicking the mouse to de-select a name.

Use the mouse to select 320 Res Screen, in the first column (Graphics
Formats). Then, go to the File menu, and choose New Graphic. Enter the
name SHR.Test for this example.

To convert The.Raven from High Res 140 (col) to 320 Res, just use the
mouse to select both The.Raven in the Oringinal Graphics column, and
SHR.Test in the Destination Graphics column. Then, choose Standard
from the Transfer menu.

As before, you'll first see the High Res image of the raven. Select roughly
the same area as before: position the mouse so the lines are just above and
to the left of the bird, hold down the mouse button, and drag up and to the
left until the other lines are just below and to the right of the bird. Release
the mouse button to go to the next step.

You will then be shown the Super High Resolution screen, with an empty
rectangle drawn on the left hand side of the screen. This rectangle indicates
the position, and the final size, of the graphic to be transferred. Move the
rectangie to the middle of the screen, and click the mouse button. There
will be a moderate pause while the Graphic Exhange converts the graphic
from High Res to Super Hi-Res. In a couple of seconds your picture will
appear, with all colors preserved.

At this point, you probably have a question: "Why was the destination
rectangle, and the converted graphic, smaller than the original?"




The answer has to do with the fact that each graphic mode on the Apple II
has a different resolution. Resolution refers to the number of pixels, both
horizontally and vertically, in each graphic screen. In the High Res picture,
there are 140 individual graphic "picture elements" (hence the term "pix-
els") across each horizontal line, and there are 192 lines from the top to the
bottom of the screen. In 320 Super Hi-Res, there are 320 pixels
horizontally, so the raven looks a little thinner since a full screen’s worth of
pixels in High Res (140) is a little less than half a screen at 320.

When you do a standard transfer, the graphic is converted to the destina-
tion mode on a pixel-by-pixel basis. Since the Super Hi-Res graphics mode
has 200 lines with 320 pixels on each line, the entire High Res graphic fills
less than half the screen from left-to-right, and leaves a total of 8 lines at the
bottom unfilled (200 - 192 = 8 unused lines).

Note: Although the Double Hi-Res graphics mode on the Apple II is
sometimes referred to as being the "560 mode", this is only in the
monochrome, or black & white, mode, where color is not displayed.
Color in the Double Hi-Res mode is created by grouping each set of four
monochrome pixels together. 560 divided by 4 = 140 actual color pixels.
The Graphic Exchnage supports both the 140 and 560 Double High Res
modes.

Does this mean that you cannot convert entire screens? Absolutely not.
The Graphic Exchange is set up to give you a wide variety of choices in
converting pictures, so that you can always get just the results you want.

What we need is a way to scale the graphic as it is being converted, and
that's just what the next section covers!

The Scaled Transfer

To see how a scaled transfer works, select the Raven and the
SHR.Testnames again, but this time, choose Scaled from the File menu.

Again, use the mouse to select just the bird from the raven picture.

This time, you'll notice that when you get to the destination graphic, you've
got the cross-hairs of the selection rectangle again. Use the mouse to line up
with the upper-right comer of the old raven image converted a little earlier.




Hold the mouse button down, and create a new rectangle that is the same
height as the old raven image, but about twice as wide. Release the mouse
button to start the conversion.

When the conversion is complete, you'll see that the raven image has been
stretched to fill the rectangle you described. It may look a little chunkier
than the original image, but that's because you're doubling each of the old
pixels into two new ones. When you convert some images from a lower
resolution to a higher resolution, there may be some distortion of the image.

Clicking the mouse will return you to the main menu screen of the Graphic
Exchange. If you wanted to save your converted image at this point, you
would select the name SHR.Test, and then choose Save As from the File
menu.

To see how the original graphic can be automatically scaled to an entire
screen as it is converted, let's look at the next transfer mode, the Full
Screen Mode. '

The Full Screen Transfer

The Full Screen Transfer mode converts an entire screen in one graphic
mode to a complete screen in an alternate mode. Using it is easy.

For this example, we'll convert the full-screen image of the raven from High
Res to 320 Super High Res. If it isn't already in memory from previous
exercises, load the file The.Reven now as a High Res 140 (col) image. To
do this, first select High Res 140 (col) in the first column (Graphics
Formats). Then choose Open Original from the File menu, and load
The.Raven from the Graphic Exchange disk.

If you have not already created a receiving format, click first on 320 Res
Screen in the first column, and then choose New Graphic from the File
menu. Name the new graphic SHR.Test.

Now you're ready for a transfer. Select the file The.Raven in the second
column. Then click on SHR.Test for the Destination graphic. Both images
should now be selected.




From the Transfer menu, choose Full Mode. The translation table will
appear. Click on "OK" to start the transfer. You'll notice that no selection
rectangle is necessary since the entire screen will be converted. A ther-
mometer will indicated the progress of the conversion. When the conver-
sion is complete, you'll see the final image. Click the mouse to return to the
menu screen.

You would save the image at this point by clicking on the name SHR.Test,
and then choosing Save As from the File menu.

Quitting The Graphic Exchange

To quit The Graphic Exchange chooseQuit from the File menu (or press
Apple-Q). This will return you to what ever program you used to launch the
Graphic Exchange, such as the Finder, etc.

Once you have quit The Graphic Exchange, you can run your application
program and load your transferred picture into your software.

If you only have one disk drive, and are concerned about having to leave
the Graphic Exchange disk in the drive, or having to swap between the
Graphic Exchange and your data disk, don't be. Once at the main menu
screen of the Graphic Exchange appears, you can remove the program disk,
put it in a safe place, and insert your data disk. Once started, the Graphic
Exchange program disk is no longer required to be in the disk drive.




Chapter 4: More Menu Choices

This chapter covers the various menu choices in the Graphic Exchange. The
previous chapter offered a tutorial on using the main functions of the
Graphic Exchange in converting graphics. This chapter will explain the
other additional features of the program that you should be aware of.

List Boxes

There are three columns of information, or list boxes, on the main menu
screen of the Graphic Exchange.

Graphic Formats

The first list box is a list of all the graphic formats currently supported by
the Graphic Exchange. Any of the formats listed can be disposed of at any
time to make more room for other formats, or the general operation of the
Graphic Exchange. To dispose of a graphic format (and free up the memory
used by it), select one or more formats in the Graphic Format list, and then
choose Unload Formats in the Options menu.

Formats not currently loaded can also be brought in from disk. To load a
new format, choose Load Formats from the Options menu, and select the
new format you wish to load. More than one format can be selected for
loading by using the shift- or Apple-key as you click on format names.

Exactly which formats are loaded when you start up the Graphic Exchange
can be specified with the Configure Auto Load... option under the Options
menu. This is similar to the Load Formats option, except that this deter-
mines which formats are loaded when the Graphic Exchange starts up. As
shipped, the Graphic Exchange loads all formats on the disk. However, you
may want to shorten this list to remove formats you are not likely to use, or
only use infrequently. When you chooce Configure Auto Load, you'll see a
dialog box with all the available formats highlighted. Use the Apple key
while you click on an entry to deselect any formats you do not want loaded
at startup. You can also click once with the mouse to deselect everything
(except for the name just clicked on), and the use the Apple key while
clicking to individually select the formats you want loaded.




Loading and unloading of graphic formats, and the configuration process is
also described later in the section on the Options menu.

Each graphic format has a corresponding file in the subdirectory
TGE.TOOLS on the Graphic Exchange disk. This subdirectory must be
present in the same directory as the TGE.Sys16 file on any disk that you
move the Graphic Exchange software to, such as a hard disk.

You can get more information about a graphic format by selecting a single
name in the graphic format list, and then choosing Format Information in
the Display menu (or just press Apple-I).

Original Graphics

Graphics in the original list are used as a source for all graphic transfers.
Graphics can be loaded into this list, but they cannot be edited, or saved
while in this list.

If you want to know what format is associated with a name in the Original
Graphics list, just select a single name in the list. You will also have to de-
select any entries in the other columns (use the Apple-key while clicking on
any additional names). Once a single graphic name has been selected,
choose Format Information from the Display menu (or just press Apple-

D). '

To remove a graphic item from the Original Graphics list, select one or
more names, and choose Dispose from the File menu (or press Apple-D).

Destination Graphics

Graphics in the destination list are used as a destination for all graphic
transfers. With the exception of the Batch mode, there must be a destination
graphic available when doing a transfer, so that Graphic Exchange knows
what the destination graphic mode will be. You can open a "dummy"
destination graphic at any time by choosing a graphic format, and then
choosing New Graphic from the File menu.

You can also load an existing graphic into the Destination Graphics list.
this would be useful if you wanted to copy a portion of one graphic image,
and paste it into another, even if the two graphics were in different formats.




Graphics can be edited with all options in the edit menu while in the desti-
nation list. Graphics can be loaded to, saved from, and newly created in the
destination list.

If you want to know what format is associated with a name in the
Destination Graphics list, just select a single name in the list. You will also
have to de-select any entries in the other columns (use the Apple-key while
clicking on any additional names). Once a single graphic name has been
selected, choose Format Information from the Display menu (or just
press Apple-I).

To remove a graphic item from the Destination Graphics list, select one or
more names, and choose Dispose from the File menu (or press Apple-D).

File Menu

Close

Close is required so desk accessories can work (i.e. so you can close a desk
accessory), but is not used by the Graphic Exchange.

Open Original

Loads a graphic of the selected type in the Graphic Formats list box into the
Original Graphics list.

You also just press Apple-O after selecting a graphic format. The fastest
way to open a new graphic is to simply double-click on a graphic gormat in
the Graphic Formats list box.

In the Load Graphics dialog box you can make multiple selections by
holding down the Apple key while clicking with the mouse. You can also
hold down the Shift key while clicking the mouse to select an entire ragne
of files.

Open Destination

Enables you to load a graphic file from disk to the Destination Graphics list
box. There are no shortcuts. The main use of this option is to enable the use
of a graphic that is on the disk as the background to a new graphic.




Once loaded into the Destination Graphics list box you are then able to
paste other graphics from the Original Graphics list box onto it, using the
Standard or Scaled transfer modes.

Save

Saves a selected graphic in the Destination Graphics list box to the current
file, but only if that file has been loaded from disk, or already saved once
before using Save As. Save is a fast way of re-saving a file to disk without
using a dialog box. Save cannot be used to save Original Graphics, or
Destination Graphics files created with the New Graphic menu choice
before the new graphic has been saved to disk at least once. Keyboard
shortcut is Apple-S.

Save As

When this is chosen, a dialog box, called the standard file interface, will
appear. This lets you select the disk and subdirectory into which your file
will be saved, and to give a name to your file. For some graphic types, it
will also give you some different options as to exactly how you want the
file saved.

To save a graphic, you first select a name in the Destination Graphic list
box. Then choose Save As from the File menu. A list of files on the
currently active disk drive will appear. If you want to save your graphic on
that disk, enter a name, and click on the Save button. If you want to save
the file in a different location, click on the Disk button to move to another
disk.

On any given disk, a folder can be opened by clicking on the folder name
(indicated by a small picture of a folder to the left of the filename), and
clicking on the button marked Open.

If you wish to create a new folder in which to put your graphics files, first
enter the name for your folder, and click on the button labeled "New
Folder". A new folder will then be created on your disk, and will show up
in the file list on the screen, although you may have to scroll up or down to
see it. Once you've created the folder, enter the actual name you want to use
for the graphic file to be saved, and then click on Save.




For certain graphic formats, there are a number of different ways the file
can be saved to disk. The most common way will always be shown as the
default. Do not change the setting if you do not have a specific reason for
using an alternative file format.

New Graphic

This creates a new Destination Graphic of the selected format in the
Graphic Formats list box. A dialog box will appear which allows you to
enter a name for the graphic. You can also press Apple-N having previ-
ously selected a single graphic format.

Dispose

This disposes of any graphics that have been selected in the Original
Graphics or Destination Graphics list box. This frees up memory for other
operations, and should be done if you are finished with a given graphic. If
the graphic has been changed, a waming dialog box will appear (this sort of
warning can be configured under the Options menu). The keyboard shortcut
is Apple-D.

Slide Show

This will automatically display all the graphics of a single format located on
a disk. It's an easy way to see all the graphics you have on a disk. Before
choosing this option, you must hae selected a single Graphic Format in the
first column. When this option is selected, a standard file interface dialog
box will appear enabling you to select the directory that contains the
graphics that make up the slide show. All sub-directories within the selected
directory can also be scanned if you select the Show Subdirectories option
within the dialog box.

You are also able to select the option to make a continuous slide show until
the Escape key is pressed.

The option to retain graphics in mémory keeps all the graphics in the slide
show in the Original Graphics list box, up to memory capacity of the GS.




Initialize Disk

This option is provided so that you can format blank disks, or erase disks
with existing files, right from within the Graphic Exchange.

The first dialog box to appear enables you to select the device to be format-
ted, and whether you want to have a physical format done. You also enter
the volume name for the initialized device.

If you are using a disk that has never been used before, click on "Physical
format". If the disk has been used before, and you want to erase all the
filesthat are presently on that disk, you can proceed without checking
"Physcical format".

Having selected the device a second dialog box appears enabling you to
select the operating system. The range of operating systems you have to
chose hear is determined by the range of File System Translators (FST’s)
you have installed. Unless you have a specific reason for choosing other-
wise, you will format your disks as ProDOS 800K disks.

If you have selected "Physical format" earlier, you'll also be offered a
choice of interleave values for the disk. The best value will generally be
shown as the default choice. If you have the grey 3.5" drives, 2:1 is the
best value. If you are using the older white 3.5" drives, 4:1 is the recom-
mended value.

Quit

This exits the Graphic Exchange, giving a warning about modified graphics
that you have not saved. It will then return you to the Finder, or whatever
other program selector you used to launch the Graphic Exchange. The
keyboard shortcut is Apple-Q.




Edit Menu

Undo

This undoes the last change to the Destination Graphic. If the graphic buffer
exceeds 128K, then changes cannot be undone. Currently none of the
Graphic Formats exceed 128 K, but this may change in the future, The
keyboard shortcut is Apple-Z.

Cut, Copy and Paste are not used by TGE, but are there for use within
Desk Accessories.

Clear

This clears the currently selected Destination Graphic to its default state,
For most graphics, this will be a black background. For Mac and Print Shop
graphics, it will be a white background. The default state is not configur-
able,

Invert

This exchanges black and white on the currently selected Destination
Graphic, leaving color unchanged. The Destination Graphic will appear,
giving you the option to select the rectangular area to be inverted. You first
select the top left hand comner and then drag the rectangle to the desired
size.

Paint

This lets you to do "touch ups" on a Destination Graphic. This option is not
meant to replace full-featured paint programs, but enables you to do simple
color editing. Its main expected use is for Icon editing and Print Shop
graphics.

The Paint dialog box lets you select the brush size and any of the colors
associated with the selected Destination Graphic. The selected graphic is
then automatically displayed for you to edit. Press the Escape key to return
to the main screen. The keyboard shoricut is Apple-P.




Custom

This is a special option that allows editing that is specific to a graphic
format. The only Graphic Format supported by this option at present is the
Icon Graphic Format. For icons, Custom lets you set the filename, filetype
and auxtype that that icon be linked to by the Finder. You can also specify
what application will be launched by the Finder if the user clicks on the
icon you're created with this function.

For example, if you wanted to create a graphic icon for Print Shop graphics,
and which in addition, would automatcially launch the Graphic Exchagne if
someone clicked on it, you would enter the following parameters using the
"Custom" option before saving the graphic file to disk.

File name: *

"*" means any name. If you wanted only files that ended in ".DHR" for
example, you would use "*.DHR"

Filetype: $0006
Auxtype: $7800

This is the filetype and auxtype that is specific to the original print shop
graphics.

Application pathname: /TGE.Disk/TGE.Sys16

This will depend on where you have stored the program Graphic Exchange.
Typically, icons are set up in such as way that they are linked to a startup
disk with no specific name, although the application is placed in a specified
directory on the startup disk. For example, if you had put the Graphic
Exchange on your hard disk in a directory named TGE, the application path
for the icon would be: */TGE/TGE.Sys16

In this case, the asterisk stands for any startup disk.

You may want to load the icon files that came with other applications into
the Graphic Exchange, and examine how they are set up using the Custom
option. Remember to load the icons as a Destination Graphic if you want to
use the Custom feature.




Display Menu

Memory Available

This displays a dialog box with a report about the memory usage in your
computer at that moment. The entries are as follows:

Total Memory: This indicates the total RAM memory in your computer. In
older ROM 01 machines, the value is likely to be 1??7?K (1000K is 1
Megabyte). In newer ROM 03 machines, the value is likely to be ??77K. If
you have expanded the memory in your computer with additional RAM, the
value will be higher.

Free Memory: This value indicates the total amount of memory currently
unused in the computer. However, more memory might be available if a
certain amount of "housekeeping” were done. That larger value is indicated
by the enext value,

Real Free Memory: By freeing up parts of memory that are occupied by
portions of the Graphic Exchange that were used earlier, but are not actually
being used at that instant, more memory can be made available. This is the
"Real Free Memory" value.

Largest Block: This value indicate how much memory is available in one
continuous chunk. Although, for example, you might have 100K of RAM
free, it would not help you if there weren't 32K of continous memory
available to load a given Super High Res graphic.

The available memory dialog box is provided mostly to give you alittle
insight into how your computer works, and to provide a clue in the event
you should get a "not enough memory available" error message while trying
to do something in the Graphic Exchange.

If you should get an error message like this, look at the available memory
report, and consider the following options:

1) If it appears you have enough Free Memory to load a particular graphic,
but the Largest Block is too small, try quitting the Graphic Exchange and
restarting your computer. Many times this will be sufficient to "clean up"
memory enough to do what you want.




2) You may also want to try Disposing of any unnecessary graphic format
and graphic files you have loaded. This will free up memory for other uses.

3) Using the Finder, or other utiltiy, you may want to disable desk accesso-
ries in the Desk Accessory folder on your startup disk. The Graphic Ex-
change disk as shipped has no desk accessories other than the Control
Panel, so this is not an option if you are starting up on that disk.

Format Information

This brings up a dialog box that gives detailed technical information about a
single selected Graphic Format. This also lists a few of the programs that
support a given graphic mode. The keyboard shortcut is Apple-I.

Original Graphic

This displays the selected graphic in the Original Graphics list box. If there
is more than one graphic selected, you are able to step through the displays
by keypress or mouse click. You can also double-click on a graphic in the
Original Graphic list box to display it.

Destination Graphic

This displays the selected graphic in the Destination Graphics list box. If
there are multiple selected graphics, you can step through the displays by
keypress or mouse click. You can also double-click on a graphic in the
Destination Graphic list box to display it.

Transfer Menu

Standard

In order to use this option there must be one Original and one Destination
graphic selected. When Standard Transfer is chosen, a color translation
dialog box will appear. A default color translation is presented, but you are
able to reassign any color translation using any of the Destination Colors.
The selected Current Translation can be changed by selecting a different
Destination Color.




You are also able to mask out any selected colors on the Current Translation
table. Those masked colors will not be transferred.

When you click on "OK" in the translation dialog box, the Original Graphic
is then displayed. The mouse is used select the area to be transferred, after
which the Destination Graphic is displayed, and you are able to position the
graphic wherever you wish on the Destination Graphic. The keyboard
shortcut is Apple-T.

Note that for graphic formats that are larger than the Apple screen, the
mouse is first used to scroll the image up or down so that the part you want
to work with is in view. Click the mouse when the image is properly
positioned. At that point, the mouse will be used as before to select a
portion of the screen, or to position the transferred graphic.

Scaled

This lets you scale a graphic as it is being converted to a new format. In
order to use this option there must be one Original and one Destination
graphic selected. When Scaled Transfer is chosen, a color translation dialog
box will appear. A default color translation is presented, but you are able to
reassign any color translation using any of the Destination Colors. The se-
lected Current Translation can be changed by selecting a different Destina-
tion Color. ‘

You are also able to mask out any selected colors on the Current Translation
table. Those masked colors will not be transferred. When you click on
"OK" in the translation dialog box, the Original Graphic is then displayed.
The mouse is used select the area to be transferred, after which the Destina-
tion Graphic is displayed, and you are able to position and size the graphic
wherever you wish on the Destination Graphic.

Note that for graphic formats that are larger than the Apple screen, the
mouse is first used to scroll the image up or down so that the part you want
to work with is in view. Click the mouse when the image is properly
positioned. At that point, the mouse will be used as before to select a
portion of the screen, or to position the transferred graphic.




Full Mode

This transfers an entire screen from one graphic mode to another. To use
this option there must be one Original and one Destination graphics se-
lected. When the Full Translation is chosen, a color translation dialog box
will appear. A default color translation is presented, but you are able to
reassign any color translation using any of the Destination Colors. The se-
lected Current Translation can be changed by selecting a different Destina-
tion Color.

You are also able to mask out any selected colors on the Current Translation
table. Those masked colors will not be transferred. The translation takes a
short time, after which the Destination Graphic will be displayed. The
Keyboard shortcut is Apple-F.

Batch

This transfer mode converts a group of selected Original Graphics to
corresponding Destination GRaphics in whatever Graphic Format is cur-
rently selected. This is the only transfer method where it is not necessary to
create a "receiving" Destination Graphic before doing the conversion. For
each of the Original Graphics selected a corresponding Destination Graphic
will be created in the selected format, with the same name as the Original.

During the batch transfer a dialog box will display the progress. The dialog
box allows the option to abort the transfer at any stage. Batch always uses
the default color translation. The keyboard shortcut is Apple-B.

If Save is chosen after a batch transfer, the original files on disk will be
replaced with the converted files. If you want to use new names, select all
the Destination Graphics to be saved, and choose Save As.




Options Menu

The Options menu contains various customizable features of the Graphic
Exchange. These include control of waming messages, how the graphic
names are displayed, and which graphic format conversion tools are loaded
when the Graphic Exchange is started up.

Adjust Color Translation

If this option is not checked, then the default color translation is always
used in the Standard, Scaled and Full mode translations. This means the
translation color table dialog box will not appear when you choose any of
the translations.

Sort Original & Destination Graphics

When these items are checked, the Graphic Exchnage automatically alpha-
betizes names as they are added to either the Original or Destination
Graphic list boxes. By choosing either of these menu items, the check mark
is "toggled", that is, switches back and forth between being marked or not.
When either item is not checked, names in the respective list box will be
listed in the order loaded, and will not be alphabetized.

Destructive Warnings

Normally, the Graphic Exchange will display a dialog box warning you
when youare about to do something that will change or dispose of a graphic
that cannot be undone. If you are working with a lot of graphics, however,
you may wish to turn off these dialog boxes. If this option is not checked,
then the Graphic Exchange will not give warnings before a Destination
Graphic is lost through the Dispose or Quit option, or before overwriting
existing files in the list box.

Configure Auto Load

As the program is shipped, the Graphic Exchange loads all the available
graphic translation tools on the disk. This is so that you will know what is
available. However, each translator takes up memory, and there are some .
translators, such as the Double Low Res format, that you are unlikely to use
very often.




The first list box is a list of all the graphic formats currently loaded by the
Graphic Exchange. Any of the formats listed can be disposed of at any time
to make more room for other formats, or the general operation of the
Graphic Exchange. To dispose of a graphic format (and free up the memory
used by it), select one or more formats in the Graphic Format list, and then
choose Unload Formats in the Options menu.

Exactly which formats are loaded when you start up the Graphic Exchange
can be specified with the Configure Auto Load... option under the Options
menu. This is similar to the Load Formats option, except that this deter-
mines which formats are loaded when the Graphic Exchange starts up.

When you chooce Configure Auto Load, you'll see a dialog box with all the
available formats highlighted. Use the Apple key while you click on an

. entry to deselect any formats you do not want loaded at startup. You can

also click once with the mouse to deselect everything (except for the name
just clicked on), and the use the Apple key while clicking to individually
select the formats you want loaded. Click on the Accept button to install the
changes.

Load Formats

Formats not currently loaded can also be brought in from disk. To load a
new format, choose Load Formats from the Options menu, and select the
new format you wish to load. More than one format can be selected for
loading by using the shift- or Apple-key as you click on format names. The
keyboard shortcut is Apple-L.

Unload Formats

Currently selected Graphic Formats in the Graphic Formats list box are
removed. You are not able to unload a graphic format if graphics of that
format are listed in the Original Graphics or Destination Graphics list
boxes. The keyboard shortcut is Apple-U.




Chapter 5: Graphic Modes

Although the Apple II family of computers boasts an enormous range of
graphics modes, each type is very different. The actual resolution in any
given mode is even affected by the amount of color used, as is evident in
Double High Resolution where the 560 x 192 accuracy is sacrificed for the
sixteen colors of 140 x 192!

The Graphic Exchange allows you to take advantage of the various modes,
and transfer graphics easily from mode to mode. Color is maintained
wherever physically possible across modes.

The standard Apple II colors used are:

Black, Magenta, Brown, Orange, Dark Green, Gray 1, Green, Yellow, Dark
Blue, Purple, Gray 2, Pink, Blue, Light Blue, Aqua, White.

Graphic Modes Supported

The following is a brief summary of the currently supported Graphic Ex-
change formts. Others may be added to the disk from time to time. For
information on any new formats, you can always load the format, select it in
the Graphics Formats list box, and then choose Format Information from
the Display menu.

Low Resolution

Resolution: 40 horizontal x 40 vertical.
Colors: 16 standard colors

Programs that use this:
Applesoft BASIC, Roger's Easel, Triple Dump, The Printographer.




Double Low Resolution

Resolution: 80 horizontal x 40 vertical,
Colors: 16 standard colors

Programs that use this:
Triple Dump

High Resolution 140 (col)

Resolution: 140 horizontal x 192 vertical.
Colors: Black, Purple, Green, Blue, Orange, White,

Programs tht use this: :

Applesoft BASIC, Triple Dump, The Printographer, Fantavision, Print
Shop Companion, Print Shop 3.0, Chart 'n Graph Toolbox, LOGO,
MousePaint, Blazing Paddles, 8/16 Paint (std. mode), HyperScreen.

Notes: This is generally the best mode to use for loading a normal High
Resolution graphic as your Original Graphic for subsequent conversion.

When converting Double High Res and Super High Res graphics to normal
High Resolution, the 16 standard colors are mapped onto the 6 normal High
Resolution colors using the following table:

Black > Black
Magenta -> Purple
Brown -> Orange
Orange -> Orange
Dark Green > Green
Gray 1 > Black
Green -> Green
Yellow -> Orange
Dark Blue -> Blue
Purple -> Purple
Gray 2 -> White
Pink -> Purple
Blue -> Blue
Light Blue -> Blue
Aqua -> Green

White > White




Some color loss can be expected when transférﬁng from a higher resolution
modeto the normal High resolution graphic mode.

High Resolution 280 (color)

Resolution: 280 horizontal x 192 vertical.
Colors: Black, Purple, Green, Blue, Orange, White.

Programs that use this:

Applesoft BASIC, Triple Dump, The Printographer, Print Shop Com-
panion, Fantavision, Print Shop 3.0, Chart 'n Graph Toolbox,
MousePaint, Blazing Paddles, 8/16 Paint (std. mode), HyperScreen,
LOGO.

Notes: Transfers from this mode may appear 'striped’ on the destination
screen (try the Normal High Resultion 140 for better results). This is the
best mode to use as a destination mode when transferring color pictures
from Super Hi-Res to normal Hi-Res. Uses the same color translation table
as Normal High Resolution Color (140 x 192).

High Resolution 280 (Mon)

Resolution; 280 horizontal x 192 vertical.
Colors: Black, White.

Programs that use this:

Applesoft BASIC, Triple Dump, The Printographer, Print Shop Com-
panion, Fantavision, Print Shop 3.0, Chart 'n Graph Toolbox,
MousePaint, Blazing Paddles, 8/16 Paint (std. mode), HyperScreen,
LOGO, ComputerEyes, LightningScan, ThunderScan, Quickie.

Notes: During transfer all non-blacks are plotted as white. The main use for
this mode is as an Original Graphic mode wher you want to strip out color
pixels.




Double High Resolution (col)

Resolution: 140 horizontal x 192 vertical.
Colors: 16 standard colors

Programs that use this:

Triple Dump, The Printographer, Animate, Dazzle Draw, Chart 'n
Graph Toolbox, Medley, PublishIt!, Blazing Paddles, 8/16 Paint (DHR
mode), TutorTech, ComputerEyes, LightningScan, ThunderScan,
Quickie.

Notes: When viewing this mode, the display type on the control panel is
automatically set to color.

Double High Resolution (Mon)

Resolution: 560 horizontal x 192 vertical.
Colors: Black and white.

Programs that use this:

Triple Dump, The Printographer, Animate, Dazzle Draw, Chart 'n
Graph Toolbox, Medley, PublishIt!, Blazing Paddles, 8/16 Paint (DHR
mode), TutorTech, ComputerEyes, LightningScan, ThunderScan,
Quickie.

Notes: When viewing this mode, the display type on the control panel is

automatically set to monochrome. All colors except black are considered
white during transfer to the Double High Resolution mode.

320 Resolution Screen (Super High Resolution)

Resolution: 320 horizontal x 200 vertical.
Colors: 16 standard colors

Programs that use this:

PaintWorks Plus, PaintWorks Gold, Deluxe Paint II, Print Shop GS,
Show Off, Fantavision GS, 8/16 Paint (320 mode), ComputerEyes,
LightningScan, ThunderScan, Quickie.




Notes: This resolution is achieved using the Super High Resolution mode
(320 horizontal x 200 vertical). Any standard Super High Resolution
graphic screen can be loaded into this mode. Areas transferred from the
normal High Resolution and Double High Resolution mode (140 x 192) to
the Super High Resolution mode (160 x 200) will remain approximately the
same size. The color palette can be changed by loading a graphic screen
with the desired palette.

320 Resolution Page (Super High Resolution)

Resolution: 320 horizontal x 394 vertical.
Colors: 16 standard colors

Programs that use this:

PaintWorks Plus, PaintWorks Gold, Deluxe Paint I, Print Shop GS,
Show Off, Fantavision GS, 8/16 Paint (320 mode), ComputerEyes,
LightningScan, ThunderScan, Quickie.

Notes: The difference between this and the "screen" mode is that this
accomodates page-size graphics created by many paint programs. The
"screen” modes are more appropriate when literally converting a screen
from one mode to another.

640 High Resolution Screen (dit)

Resolution: 320 horizontal x 200 vertical.
Colors: 16 standard colors (dithered)

Programs that use this:

HyperStudio, AppleWorks GS, PaintWorks Gold, Deluxe Paint I,
Print Shop GS, 8/16 Paint (640 mode), ComputerEyes, LightningScan,
ThunderScan, Quickie.

Notes: The palette consists of 16 dithered colors corresponding to the
standard colors. The process of obtaining 16 colors on the 640 x 200 Super
Hi-Res display is outlined in the Apple IIGS hardware reference manual.
Transfers from or to this mode will only preserve the color when the
standard palette is used.




640 High Resolution Page (dit)

Resolution: 320 horizontal x 394 vertical.
Colors: 16 standard colors (dithered)

Programs that use this:

HyperStudio, AppleWorks GS, PaintWorks Gold, Deluxe Paint I,
Print Shop GS; 8/16 Paint (640 mode), ComputerEyes, LightningScan,
ThunderScan, Quickie.

640 High Resolution Screen (col)

Resolution: 320 horizontal x 200 vertical.
Colors: 4 colors

Programs that use this:

HyperStudio, AppleWorks GS, PaintWorks Gold, Deluxe Paint II,
Print Shop GS, 8/16 Paint (640 mode), ComputerEyes, LightningScan,
ThunderScan, Quickie.

640 High Resolution Page (col)

Resolution: 320 horizontal x 394 vertical.
Colors: 4 colors

Programs that use this:

HyperStudio, AppleWorks GS, PaintWorks Gold, Deluxe Paint II,
Print Shop ‘GS, 8/16 Paint (640 mode), ComputerEyes, LightningScan,
ThunderScan, Quickie.




Print Shop Graphic

Resolution: 88 horizontal x 52 vertical.
Colors: Black and White.

Notes: Print Shop is a popular printing program for which a large number
of graphics are available. Print Shop graphics are sized so that they will
appear correctly scaled when transferred to the Super High Resolution
modes (320 x 200 and 640 x 200), the Double High Resolution (560 x 192)
mode and the Newsroom clip art mode. When transferred to other graphic
modes correct scaling may be lost.

Print Shop Graphics GS

Resolution: 88 horizontal x 52 vertical.
Colors: 16 standard colors

Notes: Print Shop GS is a new version of the popular printing program. For
consistency, the following color translation table is used:

Black ->  Black
Magenta ->  Red
Brown -> Orange
Orange -> Orange
Dark Green -> Green
Gray 1 ->  Black
Green ->  Green
Yellow -> Yellow
Dark Blue ->  Blue
Purple ->  Purple
Gray2 -> White
Pink ->  Purple

Mid Blue ->  Blue
Light Blue -> Blue
Aqua -> Green
White -> White




Quickdraw Icon (col)

Resolution: 88 horizontal x 52 vertical.
Colors: 16 standard colors (dithered)

Notes: The display for a Quickdraw icon will show the graphic, its mask,
and four views of the graphic - normal, inverted, highlighted and greyed.
The shape of the icon mask can be controlled by masking out colors and is
automatically created during transfer. The four views will show the actual
size of the icon, as it would appear with different kinds of highlighting.

MacPaint Screen (Mono)

Resolution: 576 horizontal x 342 vertical.
Colors: Black and white

Notes: You cannot read or write directly to a Macintosh disk, but you can
write to an Appleshare network to interchange a MacPaint graphic between
GS and Macintosh computers, or use the Apple File Exchange to move a
file to and from Macintosh disks.

MacPaint Document (mono)

Resolution: 576 horizontal x 720 vertical.
Colors: Black and white.

Notes: The MacPaint document is 576 pixels across by 720 lines high. A
corresponding mode is not available on the Apple IIGS. This means that
MacPaint documents must be displayed on the 640 x 200 mono Super Hi-
Res screen. Only 200 of the 720 lines can be displayed at any one time. The
area to be displayed is controlled by the scroll bar on the right hand side of
the screen. Both the mouse and the arrow keys can move the scroll bar. The
screen is not redrawn until you click the mouse or press the Return key. If
you click on the mouse or press return without moving the scroll bar, you
will be returned to the Main Menu.




Unrestricted 320 RGB

Resolution: 245 horizontal x 192 vertical.
Colors: 256 colors (16 unique per any given screen line).

Each pixel is stored as a full 12 bit RGB value. During display the Graphic
Exchange automatically calculates the best possible 16 palettes and up to
256 colors to be used for display. This enables the simultaneous display of
different color palettes.

Newsroom Clip Art (See Appendix A on TGE Version 3.6)

Resolution: 245 horizontal x 192 vertical.
Colors: Black and white.

Notes: A older version of the Graphic Exchange is included on the program
disk that can read DOS 3.3 disks with Print Shop and Newsroom graphics.
Use this to convert the raphics to one of the mode supported by the GSOS
version of the Graphic Exchange (the one this manual describes), and then
further convert the graphic as necessary.

Newsroom is a popular desktop publishing type of program for which a
large number of graphics are available. Newsroom disks use a custom
operating system which has been duplicated by the Graphics Exchange
enabling users to load from and save to Newsroom clip art disks. All colors
except black are considered white during transfer to Newsroom clip art
mode. Newsroom graphics are sized so that they will appear correctly
scaled when transferred to the Super High Resolution modes (320 x 200 and
640 x 200), the Double High Resolution (560 x 192) mode and the
Newsroom clip art mode. When transferred to other graphic modes correct
scaling may be lost.




Newsroom Photo Mono (See Appendix A on TGE Version 3.6)

Resolution: 231 horizontal x 168 vertical.
Colors: Black and white.

Notes: Newsroom photos are rectangular images of various sizes. The
resolution shown above is only the maximum size. When an area is trans-
ferred to this mode, the Graphics Exchange automatically keeps track of the
transfer so that when the picture is saved, only the transfer area is saved to
disk.




Appendix A: Special Uses for Version 3.6

It's unusual to find an older version of a computer program included with
the new version, but we've done just that with the Graphic Exchange for
some very specific reasons. In upgrading the Graphic Exchange to work as
a true GSOS program, we have had to give up a few features that were
present in the old software, specifically:

« Ability to directly read DOS 3.3 and Macintosh disks.
« Ability to store as a workspace in SoftSwitch.

At some point in the future, Apple Computer may add the ability to GSOS
to read both DOS 3.3 and Macintosh disks, but in the meantime, you can
use the older version (3.6) of the Graphic Exchange should you need to
directly read a DOS 3.3 Print Shop or Newsroom disk, or a Macintosh disk
with a MacPaint file.

Once a graphic has been loaded from a DOS 3.3 or Mac disk, you can save
it with the 3.6 version of the Graphic Exchange, quit that program, and then
load it back into memory with the newer version of the Graphic Exchange
provided in this package.

In regards to SoftSwitch: SoftSwitch is another software program from
Roger Wagner Publishing, Inc., that lets you have up to nine different
ProDOS 8 or DOS 3.3 programs in your computer at the same time, and to
instantly switch between them. In addition, it can copy graphics from the
Graphic Exchange (version 3.6) in one of the workspaces, and paste these
graphics directly into other programs in the other workspaces. If you have
the SoftSwitch software, see that manual for specific details.

Following is a tutorial taken from the original Graphic Exchange manual
that will explain enough about how to use the older version to let you load
the necessary graphics from a Print Shop or Newsroom data disk (DOS 3.3)
or a Mac disk. Although there are many other features in the older version,
they are not documented here, since this additional software is provided
solely to perform the specific functions not addressed by the newer version.
However, you'll find the older version similar enough to the new version,
that with a little experimentation, you're likely to be able to use any of the
features of version 3.6 while you're in that program.




Mini-Tutorial

This tutorial begins by leading you through the transfer of a Double High
Resolution graphic to the Apple IIGS Super High Resolution mode. This is
exactly the process you might use later to transfer pictures created by any
of the Apple Ile Double High Resolution paint programs like Dazzle Draw
or Blazing Paddles.

Starting The Graphic Exchange

Normaily, when you start up the Graphic Exchange, it goes directly to the
GSOS version of the program on the disk. However, an optional feature
has been built into the disk. If you hold down the option key while the disk
is starting up, the ProDOS 8 version (3.6) of the Graphic Exchange will be
started up.

We'll start by assuming your Apple IIGS is tumed off, with nothing in the
3.5" startup disk drive. Place the Graphic Exchange disk into your drive,
and turn the Apple IIGS computer on. Hold down the Option key while the
"thermometer" advances across the screen. After a while, you'll see the
Graphic Exchange title screen for version 3.6.

Throughout this program, the lower left comer of the screen provides
helpful prompts like this "Use arrows or mouse to select," or "Press any key
to continue,” etc. In the case of the title screen, the first prompt is "Press
any key to continue." Press the spacebar or Return key now. This takes you
to the Main Menu of the Graphic Exchange.

Display graphic is highlighted. In the top right hand corner of the screen, is
a message that always tells you what pressing the Escape key does.
Throughout the Graphic Exchange, the Escape key is used to "back out" of
the current operation, and return to a previous level. In this case, the
display shows that pressing the Escape key can be used to quit the Graphic
Exchange, and return to the program selector, if any, that you are using.

Note: A program selector is a program launching utility such as the Finder,
DeskTop, ProSel, or any other similar program.
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Pressing Return or the mouse button will select the inversed choice. Press-
ing the up or down arrows, or moving the mouse in the corresponding
direction, will cause the inversed choice to change.

Try using the up- and down-arrow keys, and the mouse, to move the
highlighted bar up and down on the screen. Do not choose anything yet.

How to Load A Graphic

Move the mouse down so that Load graphic is highlighted, then click the
mouse button, When you do this the sub-menu will be displayed as shown
below:

Note: you can also use the arrow keys and Return to select any menu item.
These instructions, will for the most part, refer to using the mouse to select
an item, but you can use either the keyboard or the mouse, depending on
which you prefer.

The list of graphics types that you see on the right hand of the screen are all
the various graphics types that the Graphic Exchange can load, save and
manipulate. You'll even notice at the bottom of the list that the Graphic
Exchange can even read Macintosh disks, and load MacPaint files.
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Move the mouse now, and the highlight bar on the right column follows
your every motion. Highlight Print Shop, and click the mouse button. The

following screen will appear:
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The screen shown above displays the current prefix in inverse, and a list of
the available drives by name in the right column. Just by clicking on one of
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the other devices, you can select it to be the new prefix. If the disk you want
isn't there, you can put a disk in a drive, and then click on Review online
volumes. The Graphic Exchange will then re-scan all the disk drives, and
then display the name of the new disk.

Important: If you had not already placed a disk with your graphics in
the drive (includeing DOS 3.3 or Mac disks) when you started up the
Graphic Exchange, "Review Online Volumes" should be done when
you put a new disk in the drive.

Insert a Print Shop data disk with some graphics on it (sorry, but Graphic
Exchange cannot read the original copy-protected Print Shop disk itself),
and choose Review Online Volumes. You'll see a new entry in the disk
device column labeled DOS.3.3.

Use the mouse to move the highlight the DOS 3.3 name, and then click the
mouse. The DOS 3.3 Print Shop disk now becomes the current prefix, and

is highlighted.

Be sure that DOS.3.3, under the phrase "Current Prefix" on the left side of
the screen, is highlighted and click the mouse. A list of all the Print Shop
graphics on that disk should then appear.

You can now use the mouse or the up- and down-arrow keys to select a
graphic to load. Click the mouse (or press Return) when the graphic you
want has been selected. The graphic will be loaded and displayed. Click the
mouse to return to the main menu.

To view the picture again, you can highlight Display graphic, and click the
mouse button (or press Retum). When you do, you'll see the display on the
following page.

The checkmark next to the Print Shop entry indictates that a picture of this

type is now currently in memory. The Graphic Exchange will allow you to
load one of each type of possible graphic format, provided you have suffi-

cient memory in your computer.
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For now, let's see what's involved in converting a Double Hi-Res graphic to
another format. Press the Escape key to go back to the Main Menu list of
options. (Notice that in the upper right comer of the screen, the Graphic
Exchange reminds you that pressing Escape will activate the Main Menu!)

Transferring A Graphic

Back at the Main Menu, select the option Standard transfer. Once you've
chosen this item, the list of picture types appears again. Notice the check
mark beside the Print Shop entry. At the lower left of the screen, the mes-
sage "Select source graphics mode" appears.

The Graphic Exchange is ready to transfer, and needs to know what graphic
screen you want to be your source graphic. Use the mouse to select Print
Shop (the one with the checkmark).

Your Print Shop graphic will appear with a tiny rectangle in the top left
comer of the image area, This small rectangle now acts as the cursor for
your mouse. Move the mouse to see how the cursor moves, but don't click
the mouse yet. Because a Print Shop graphic is not a full-screen image, the
mouse movement is limited to the area of the graphic itself.




For this example, position this cursor at the top left of the graphic area.
This spot will be the upper left corner of the graphic to be transferred.

Press the mouse button, and keeping the mouse button down, move the
mouse diagonally down to the lower right comer of the screen. You will
notice that a rectangle is created, following your movement. This indicates
the part of the graphic that you would like to transfer. Continue to move the
mouse down to the right till the rectangle forms a frame around the entire
graphic. Then release the mouse button.

When you release the mouse button, the screen will return to the text
menus, and you will again be presented with the list of graphic types. This
time, however, the prompt at the bottom of the screen now asks you to
"Select destination graphics mode". Now The Graphic Exchange wants to
know what screen you wish to transfer the graphic to.

Let's try the Super High Resolution screen. Move the mouse down to select
640 super-res / COL / 320 x 200 mode, and click the mouse. This is the
mode that HyperStudio and AppleWorks GS use.

You will then be shown the Super High Resolution screen, with an empty
rectangle drawn on the left hand side of the screen. This rectangle indicates
the position, and the final size, of the graphic to be transferred. Move the
rectangle to the middle of the screen, and click the mouse button. There
will be a moderate pause while the Graphic Exhange converts the graphic
to Super Hi-Res. In a couple of seconds your converted picture will appear.

Saving A Graphic

To save our new Super High Resolution graphic, select Save graphic.
When the graphic list appears, select 640 super-res / COL / 320 x 200
mode. You will then be presented with the Super High Resolution save
screen as shown on the following page.

On the Apple IIGS, there are a variety of file formats used for storing Super
Hi-Res pictures. Virtually every graphics program can load the PIC format,
which is an uncompressed ("unpacked") 32K file of the entire picture. '
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However, depending on which application program you wish to transfer
your graphic to, you can select any one of the options offered in the right
hand column. For now, choose the PIC format.

Note: For most types of graphics, you will not have to choose a filetype to
use when saving the graphic. Instead, the Graphic Exchange will just ask
for the filename to use when saving the graphic.

After you choose your file type you will be prompted to select your Pro-
DOS prefix. For now, use the mouse to select the Graphic Exchane disk by
highlighting TGE in the disk device list, and clicking the mouse.

When /TGE/ is listed as the "current prefix", click on "Sample.Pics" to
select that folder. Finally, click the mouse with "/TGE/SAMPLE.PICS/"
highlighted.

If there were any Super Hi-Res graphic files on the disk, a list of the other
pictures already saved to the disk would be displayed so that you do not ac-
cidentally duplicate file names. You will then be prompted for a filename in
the bottom left hand corner. Enter the name PS. TEST for now. Press Return
when you've entered the name and are ready to save the file. You have now
transferred and saved a graphic. Congratulations! The graphic can now be




used in HyperStudio, AppleWorks GS, or any other program that uses 640
mode Super High Res clip-art.

You can also just load a Print Shop graphic from a DOS 3.3 disk, and then
save it back to a ProDOS disk as a Print Shop graphic, without having to
convert the image to a new format at all. Some ProDOS programs can
import Print Shop graphics once they've been transferred to a ProDOS disk.

Converting MacPaint documents from a Mac disk (400K or 800K, HFS or
MEFS - but not disks written to by a Mac II) is done the same way. Just put
the Mac disk in your 3.5" drive, and choose Macpaint doc as the graphic
format to load.

Quitting The Graphic Exchange

To quit The Graphic Exchange press the Escape key from the Main Menu.
The prompt Quit The Graphic Exchange now (Y/N)? will appear. Press
"Y" to quit the program. Press "N" to go back to the main menu screen.

If you have started up using the 3.5" Graphic Exchange disk, you will then
go back to the usual GSOS version of the program, where you can work
further with your graphics.

When you are done using the Graphic Exchange disk, you can just remove
the disk from the drive, and tum off the power, or press Control-Apple-
RESET to restart the computer with another disk.

Once you have quit The Graphic Exchange, you can run your application
program and load your transferred picture into your software. If you are
using the program switcher SoftSwitch, be sure to quit the Graphic Ex-
change from the Main Menu. Do not just discard the switched program
(clearing the workspace). Quitting the Graphic Exchange "property” is
necessary so that the Graphic Exchange can release the memory it has
requested for the storage of all the various graphics pictures.




If you only have one disk drive, and are concerned about having to leave
the Graphic Exchange disk in the drive, or having to swap between the
Graphic Exchange and your data disk, don't be. Once at the Main Menu of
the Graphic Exchange appears, you can remove the program disk, putitina
safe place, and insert your data disk. Once started, the Graphic Exchange
program disk is no longer required to be in the disk drive.




